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LTspice (also known as Spice) Walkthrough 
 

 

There are a variety of circuit simulation programs available.  We use LTspice XVII at VMI because it fast, stable, and freely 

available for students to install and use on their laptops.  You can find it on my Angel homepage for this course.  The bad 

news is that the interface on this application, as on many engineering-oriented applications, borders on the user-hostile. This 

tutorial provides quick walkthroughs for the most common types of problems students need to solve using LTspice. 

 

Gotcha: If you start working on a networked drive and get a time-out auto-logout, your schematic will be toast.  I recommend 

frequently saving to a thumb or network drive, and always working on the same machine since a different machine could 

conceivably have a different LTspice version. 

 

Walkthrough #1: Model a simple voltage divider 

 

This walkthrough will create and analyze the simple voltage divider to the right.   

 

 

Open up a blank schematic 

• Open LTspice XVII, and from the menu, File → New Schematic 

• Save it right away: from the menu, File → Save As.  Give the schematic a simple name with no spaces under “Name” 

(e.g. EE223_Lab2).  Save it in your networked drive folder or your personal USB key, not on the local machine.  Press 

“Save”. 

 

Add a 10V source 

• Click the icon on the right side that looks like this:  or from the menu, Edit → Component.  This icon lets you place 

all components, including power sources, resistors, capacitors, grounds…everything.  Find the “voltage” component, 

double-click to select it, and place it in your schematic by clicking once.  If you click again you’ll place a second voltage 

source; you don’t want this, so to get out of “create voltage source” mode, press Esc. 

• How to delete and move components: it’s not select and drag, or select and delete, like in Word.  Instead, you have to 

select the action first, and then select the thing you want to change.  Create a second voltage source right now to practice: 

o To delete the second voltage source, press the “cut” tool  or press the “delete” key then click on the offending 

voltage source.  Press Esc to exit delete mode. 

o Move your desired V1 source to the left middle screen by clicking the “move” icon .  If you forget which it is, 

hover your mouse over the icons for a tooltip.  Move your mouse, and click to place it.  Press Esc to exit move 

mode. 

• To set the voltage to 10V, right-click inside the symbol (do NOT right-click on the “V” or “V1” text outside the symbol). 

o Set the DC value to 10V (the “V” at the end is optional) and leave the series resistance box empty) 

o Want to see some of the amazing types of voltage sources LTspice can simulate? Press the advanced button.  The 

advanced ones you’ll use in future courses include 

o PULSE (think: “Square wave source that looks like this: ” ) 

o SIN (think: “Sin wave source that looks like this:” ) 

o Cancel out of advanced mode, and press OK to update the voltage source’s value to 10V. 

• Save your work!  Ctrl-S or from the menu, File → Save. 

• Review: to make a 10V source you first placed the part using  and selected “Voltage”, then you set the value of the 

source by right clicking inside the symbol.  You moved or deleted parts by first pressing  or  and then selecting 

the part. 
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Add two resistors to make a voltage divider 

• You could click the  and choose “resistor”, but resistors are so common they have their own icon: . Click it and 

place two resistors stacked vertically but separated by a small distance to the right of the voltage source.  Click “Esc” to 

exit resistor-placing mode. 

• Don’t like the orientation of your resistors?  Try placing one horizontally-oriented.  To do this, choose the resistor icon 

again as you did above, but before placing the resistor, click Ctrl-R to rotate it.  Place this horizontal resistor, then delete 

it using the technique you learned in the last section. 

• Right-click resistance symbol (not the text!) and make the top one 6k and the bottom 4k.  Save your work! 

• Review: To place a resistor, choose  and right-click the symbol to set the resistor’s value.  Ctrl-R before placing to 

rotate. 

 

Add the ground and wire everything together 

• Voltages are measured relative to a point you select called “ground” (you might say “The voltage along this wire is 2V 

higher than ground”).  You must therefore specify where you want to call ground before you analyze your circuit. 

• Click the  icon and place it below the voltage source so there’s a little space separating them. 

• To wire the parts together, press the  iconto enter wiring mode. 

• Click on one component end and then click on another component that you wish to wire together.  If you did it right the 

open square ends of the wire will vanish and the wire won’t follow the cursor anymore. 

• Repeat to wire all components together. When you place a wire on another wire, it will form a closed square indicating a 

connection.  Compare your result to the figure on the previous page.  Save your work. 

• Hint: To check your work, check to make sure there are no open boxes (unwired connection points). 

• Review: Place a ground using  and wire components together using . 

 

Run the analysis 

• First you must specify what type of analysis to run.  From the menu, choose Simulate → Run or press the  icon. 

• There are six different types of analyses you can run.  You want “DC op pnt” (for “DC operating point” – it figures out 

what voltages and currents exist if the sources are not time-varying but fixed at a particular voltage), so choose it. 

• Other common types: 

o Transient: plots time-changing voltages in circuits with time-varying sources (e.g. squarewave).  Used in EE223. 

o AC Analysis = sweep an AC source’s frequency.  You’ll use this in EE230 and later. 

• Choose “OK”.  An analysis window will popup and show the voltages at, and currents through, various cryptically-

named nets like “n001”.  Also, a small “.op” text will show up on the schematic, showing that the schematic uses a DC 

Operating Point analysis. Great, so what’s the voltage across R1?  To find this out, you’ll need to label the nets across 

R1: 

o Close the textbox analysis window. 

o Label the top wire “R1Top” by pressing the  “label net” icon, type in “R1Top” in the textbox, and then press 

“OK” and place so the small open box touches the top wire.  That top wire is now called R1Top.  Press the  to 

run the analysis again, and note that the voltage at R1Top is 10V, set by the voltage source. 

o Repeat the above step to label the net between the resistors as R1Bottom, but this time note that if you place the 

label’s square box between the resistors that the text will be obscured by the resistor symbols.  Instead, place it 

hanging out in the air to the right of the junction of the resistors, and then wire it into the junction of the resistors 

using the  icon. 

o Now press .  The voltage across R1 is the voltage at R1Top – the voltage at R1Bottom = 10-4 = 6.  Save your 

work. 

 

• Review: Find DC voltages and currents using  and 

choose “DC op pnt”.  Label wires first using  to 

make results understandable. 
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Walkthrough #2: Run a transient analysis 

 

In this walkthough you’ll build the schematic shown to the right with a 1Hz 1Vpp squarewave 

source, and analyze voltage across the lower capacitor for 5 seconds.  A “5 second transient analysis” 

means “simulate an oscilloscope measuring the voltage for 5 seconds”. 

 

Build the circuit with the squarewave source 

 

• Follow the walkthrough #1, but notice R1 is 100k and a 5uF capacitor is used (use the capacitor icon). 

• Set the squarewave: right-click the body of the source, leave both 

textboxes blank and choose the “advanced” button. 

o choose PULSE to select a squarewave 

o  to make the source ±1V, set Vinitial to -1V and Von to 1V. 

• To make it a 1Hz squarewave, the period T = 1/frequency = 1 second.  It 

spends half that time on and half that time off, so “Tperiod” is 1 and “Ton” is 

0.5s. Set the rise and fall times to something non-zero, but small, e.g. 1p. 

• In summary, the squarewave values that are non-zero are Vinitial, Von, 

Tperiod, Ton, Trise, Tfall as summarized in the graph on the right. 

• The text description for the source probably obscures other things in the schematic, so select the  icon and then select 

the text (not the icon) and move the text to the top. 

• Trise and Tfall predictably specify how long it takes the squarewace to rise and fall.  You would think they should be left at 

zero.  You would be wrong!  If you leave them at their default 0 values, they will be replaced by a really bad value of 

about 5% of the tperiod time, making what should be a squarewave look trapezoidal.  Instead, replace the default 0 for both 

with a 1ns time.  This is so short compared to your ton and tperiod values that it will look like a perfect squarewave. 

• To make the squarewave source start oscillating immediately from Vinital to Von, choose 0 for Tdelay (time delay). 

 

Run the analysis 

• Choose  and choose the Transient analysis tab. 

• The goal is to view the voltage across the capacitor for the first 5 seconds, so choose a stop time of 5 seconds, a start-

saving-data time of 0 seconds, and leave all other options blank or unchecked.  Press OK to run the analysis. 

• Gotcha: if you don’t make a reasonable choice for the Stop Time (e.g. you are analyzing a 1MHz waveform and choose 

to examine it for 5 seconds or 5 million cycles) you will pay for 

it in the days it will take your simulation to run. 

• You now see two windows: your schematic window and the 

output window that represents an oscilloscope screen.  To view 

the voltage across C1, click the top of C1.  This displays the 

voltage at that wire relative to ground, which conveniently is 

across C1. 

• Gotcha: if you point at a component instead of at a wire, you 

will plot the current through that component, rather than the 

voltage between the wire and ground. 

 

Hints 

• Label the nets using the technique discussed in the above “Voltage Divider Walkthrough” to make the net names more 

understandable. 

• When the plot window is displayed, clicking at different points on the schematic keeps adding voltage waveforms on top 

of whatever is already being displayed.   

• To delete waveforms, press the delete key and then select the text of the waveform you wish to delete.  The text is 

displayed at the top of the plot. 

• You can directly plot the voltage difference across a component by dragging the mouse on the schematic.  To plot the 

voltage across the resistor, for instance, click the wire at the top of the resistor, then while keeping the mouse button 

down, drag to the bottom of the resistor and release. 

• Need to simulate a step response?  Use a Voltage source, then click “advanced”, “pulse”, and choose Vinitial = 0V, Von 

= 1V and keep everything else blank.  This will step instantly from 0 to 1 and then stay there.  If you need to simulate a 

waveform that jumps from 3V to -2V at t=0, for instance, use the same trick: PULSE(3,-2). 
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Walkthrough #3: Using OPAMPs 

 

In this walkthough you’ll build the unity-gain opamp buffer shown to the right, and plot the steady-state 

DC voltages.  To determine its response to a step input, see the Transient Analysis Walkthrough, and to 

find its Frequency Response see the AC (Bode Plot) Analysis Walkthrough. This walkthrough assumes 

you have already completed Walkthrough #1 and know how to start up LTspice and make and analyze a 

simple voltage divider. 

 

Build the circuit 

• Start LTspice and save a new, blank schematic. 

• Create a voltage source (remember , voltage) and make it +5V.  Ground the bottom end as shown in the schematic. 

• Add the opamp by pressing .  Opamps are grouped under the opamp folder.  Scroll to the end and choose the 

generic “opamp”.  Wire it up to be a buffer as shown. 

• Label the output node Vout. 

• Run a DC operating point analysis as described in the first walkthrough.  It will error out!  When you added the opamp, 

there was a small notice saying you must add a “.lib opamp.sub”.  Go back to that opamp selection screen ( , opamp 

folder, to the end and select opamp) and see it in the upper right window.  To comply, from the schematic window 

choose the add Spice directive icon , click the “SPICE directive” option, and write “.lib opamp.sub” in the text box 

without the quotes.  Click to place it neatly anywhere on the schematic. 

• Run the DC operating point analysis again, and note that it correctly estimates the opamp output voltage as 4.9995V.  

Remember back to the finite gain opamp model?  It should be Vin (A-1)/A where A is the open loop opamp gain, so this 

implies the opamp has about 100,000 gain. 
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Walkthrough #4: Run an AC (Bode-Plot) Analysis 

 

In this walkthough you’ll verify that the first-order lowpass filter shown to the right has a 3dB 

frequency breakpoint at 1kHz by measuring its output voltage at the voltage marker probe as the input 

sin wave sweeps from 10 Hz to 100 kHz.  This is called an “AC analysis”. 

 

Build the circuit 

• Follow the walkthrough #1 directions to build the circuit, but notice R1 is 100k and a 5uF 

capacitor is used (use the capacitor icon).  To set up the sinusoidal sweeping source correctly, 

right-click the icon body, leave the text boxes blank and choose “Advanced”.  You might think 

you would choose the SINE option, but that is for transient analysis covered in the previous section (e.g. “how does the 

circuit behave in the first 5 seconds if we suddenly connect it to a sine wave”, vs. what we’re doing here which is “how 

does the circuit behave if we sweep the ac source between 10Hz and 100kHz”).  Instead, leave the Function area set to 

“none” and change the “Small signal AC analysis” area to 1V for AC amplitude and 0 for AC phase.  Press OK.  

• Gotcha: As in the first walkthrough, click the schematic icon, not the text, to change values. 

 

Run the analysis 

• Choose  and choose the AC Analysis tab.  We want to sweep from 10 Hz to 100 kHz.  Those are multiples of 10, so 

choose “Decade” for type, choose 10 for points per decade, 10 for Start Frequency, 100k for Stop Frequency. The 10 

points per decade means it will compute the response at 10 evenly spaced points between 10Hz and 100Hz, another 10 

evenly spaced points between 100Hz and 1kHz, etc.  That number is fairly arbitrary; if it is too small the graph won’t be 

smooth, and if it is too many it will take a long time to calculate. 

• Gotcha: you can never use 0 for the start frequency, even if using a linear sweep.  Press OK. 

• To view the transfer function across the capacitor, click wire at the top of the capacitor.  That will display both the 

magnitude of the transfer function (output voltage magnitude vs. frequency) as a solid line and the phase (output voltage 

phase vs. frequency) as a dotted line. 

 

Alter the plot window 

• To change the axis scaling, left click it.   

• To remove the phase plot but keep the magnitude plot, click the vertical phase axis on the right side of the graph. 

• To add a grid, right-click in the middle of the plot area. 

• Notice how I changed the grid below by left-clicking in the left axis window to draw a gridline at 3dB.  Although it 

didn’t draw a line at every 3dB point because the window is too small, by forcing the first one to be drawn shows clearly 

that the circuit is a lowpass filter with a -3dB point at 1kHz, as expected. 

 


